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1、Preface 
 
 
 
 
With DrView, Central Management System allows administrator to manage several 
DVR systems through network located in different sites from one point of control. 
 
Each DrView system can manage up to 64 sets of 16CH DVR. You can monitor the 
DVR through network at any time. You can also proceed to set up the remote system 
configuration. 
 
With user friendly GUI, administrator can monitor the DVRs very easily. 
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2、Installation 
 

 
 
DrView can serve up to 64 DVR (1024 channels) at the same time. Before the 
installation, make sure your computer meets the following minimum requirement. 
 

DrView Requirement 
OS Windows 2000, Windows XP 
CPU P4 2.6G above 

Display Card 
64MB above 
(nVIDIA TNT2/ GeForce2/ GeForce4 are 
most optimal), 1024*768 screen resolution 

RAM 256MB above 
Hard Disk 20 GB above 
Network Card 10/100Mbs 
Mouse PS/2 or USB compatible 
CD-ROM General 
USB Interface 1.1 / 2.0 
DirectX V7.0 & above 
 
 

2-1、Install DrView 

1. Insert the installation CD.  
2. Then go to the directory E:\utility\DrView (suppose E:\ is your CD-ROM drive) to 

run the Setup.exe and follow the steps. 
When finishing the setups, it will show up the message.  
Then, you can find the application from the Windows Start menu.
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3、Profile Manager  
 
 

After the installation, start the application by clicking the icon  on the desktop 

or in the folder of “DrView” from the Windows Start menu. The “Profile Manager” 
will show up to let the user to Create, Delete, Edit, Import, Export or Open “User 
Profile”. 
 

 
 
First time to use DrView, user has to create a new “User Profile” to save the 
configuration of DVRs. You can create different Profiles for different configurations 
at the same time. Next time when you start the DrView, you don’t need to create a 
new User Profile any more and you just open one of Profile you prefer.   

 

3-1、Create a New User Profile 

Click “ New” on the Profile Manager, it will show the Profile Setup 
Dialog as following  
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Key in the “Profile Name”, “Supervisor Password”(R/W Password), and “ User 
Password”(Read only Password) in the Profile Setup Dialog.  

 
After the new profile has been created successfully, the new profile icon will be 
shown on the Profile Manager screen as following. Refer to 3-1-6 to enter the new 
profile. 

 

 

Note: 
 “Profile” name can’t exceed 50 characters. 
 “ Profile name only supports Chinese & English words and does not support 

special marks. 
 Password can’t to exceed 30 characters. 
 Password only support numbers& English character.  
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3-2、Delete Profile 

If you want to delete the User Profile, click “Delete” button. Then, the system will 
request you to enter the Supervisor password. Only supervision has the authority to 
delete the Profile.  

 
 

3-3、Edit Profile 

If you want to edit the Profile, just select it and click the “Edit”. The system will 
request you to enter the Supervisor password. Only supervision has the authority to 
edit the Profile. Therefore, enter the Supervisor password. 
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3-4、Import profile 

You can import the backup profile to system. It’s easy for copying the settings 
between computers.  

Click “Import” button, and select the *.bkp file which you want to import. (the file 
you have exported before) 

 
 
 

 
After importing file, the imported file will be added in the Profile Manager screen as 
following,  

 
 

 

3-5、Export Profile 

If you want to back up the profile or execute DrView on another computer but use 
the same profile, you can export the “ Profile”.  

Please choose the profile you want to export and click “Export” button. 
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The system will request you to enter “Supervisor” password. Enter the password and 
the address of the saved profile will show up. You can select the path to save the .bkp 
file which has just been exported, and it will appear on the appointed address. 

 

 
 

3-6、Login 

The user can choose the created Profile, enter the password and then start to login. 
There are two kinds of password identification-Supervisor and User password. Each 
one has different authority in DrView. The following is comparison tables of the 
authority. 
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Profile Manager  

New Delete Edit Import Export Login
Sequencer Monitor 

Options 

Supervisor  ○ ○  ○ ○ ○ ○ 

User  ╳ ╳  ╳ ○ ○ ╳ 

 

Quick Select Tag  
Save Delete Rename

Full 
Screen Snapshot Setup System 

Status Playback 

Supervisor ○ ○ ○ ○ ○ ○ ○ ○ 

User ╳ ╳ ╳ ○ ○ ╳ ○ ○ 
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4、Main Screen 
 
 
 
When you login the profile successfully, the following monitoring window will 
appear.  

 

Date & Time 

Exit 

DVR List 

Preview Window 

 

 System status Sequencer 
 

Full Screen    
Snapshot 
Setup 

Playback 
Motion to Zoom

E-MAP 

Display Mode 

Quick Select Tag 
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4-1 Main Screen 

After finishing the DVR configuration (refer to 4-3 “DVR setup”), go back to Main 
Screen and it will show the following screen.  
 

 

Drag & Drop Preview Window 

 

 

Click ＋ button in front of the DVR in the window of DVR List and it will list all of 
the cameras connected to this Remote DVR. Click any listed camera and the screen of 
this camera will be displayed in the “ Preview Window”. You can decide if you want 
to display this camera in the Spilt Window. If yes, just click this camera, Drag and 
Drop it to any spilt window you want to display. You can also Drag and Drop a 
group of cameras to the Left Spilt Window at one time. When clicking the right button 
of mouse on one of the DVR in the DVR List, it will show the following dialog box. 
Select “ Add to Monitor” and there are four Group 1, 2, 3, and 4. Choose the Group 
you want to add at one time.    
   

                          

Add to Monitor 
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4-1-1 Zoom in/ Zoom Out Adjustment  
You can Zoom in or Zoom out any Spilt window. Double click on any split window 
and it will be enlarged to Full Display mode. You can double click again on this 
enlarged window and it will go back to the original spilt mode In Full Display mode, 
you can enter [+] or [-] to Zoom in or Zoom out the screen. There are ten display 
modes “ Full, 250%, 225%, 200%, 175%,150%, 125%, 100%, 75%, 50%”.  

 
                      Full Display Mode 

4-1-2 Camera Options 
Click right button of mouse on any split window, the screen will appear the following 
list for camera options.  

 

 
The following table is the description for each function.  

Function Description 
Execute -Enable: Enable to display the camera in the Spilt Window

-Disable: Disable to display the camera n the Spilt Window
Sequencer Time -Set up the Sequencer timer 
Motion Detect -Enable/Disable Motion Detection function.  

Alias Name Setup -Name the Camera Alias name 



 
 

 
 

12

4-1-3 PTZ Camera 
If remote DVR has PTZ camera connection, the PTZ control panel will pop up when 
the screen is displayed in Full Display Mode. PTZ controls include “Zoom In”, 
“Zoom Out”, “Focus Near”, “Focus Far”, “Auto-Focus”, and “PTZ Speed”. 

 
 

 

 

Focus Near 

 
When the user adjusts the PTZ control, it will not on
effect the recording result.  
 

 

4-2 Display mode 

There are 10 kinds of Split modes and 3 kinds of Seq
These 10 kinds of Split modes are 4 splits, 6 splits, 8
16 splits, 25 splits, 36 splits, and 64 splits. The defau
Zoom Out
Zoom In 
Focus Far 
Auto-Focus 
PTZ Speed 
ly change camera image, but also 

 

uencer modes in display mode. 
 splits, 9 splits, 10 splits, 13 splits, 
lt option is 64 splits   



 
 

 
 

 

 

4-2-1 Sequencer Mode 
The DrView provide three kinds of Sequencer Modes, 1- channel, 4- channel and 

64-channel Sequencer. When you click Sequencer icon , it will show three options 

to let you select. However, 64-Channel Sequencer is just for TV Wall display. That is 
64 channel sequencer option will not appear if TV Wall display function is not 
enabled.     
 
When you select 1-channel sequencer mode, the screen will display sequentially from 
cam 1 to cam 64. You can set up Camera sequencer timer according to 4-1-2 Camera 
Option. If any camera is disconnected, the sequencer will skip over it to the next 
connected camera channel,  
 
When you select 4-channel sequencer mode, the Main screen will change to 4-split 
display mode. The 1st Spilt Window will display Cam 1 to Cam 16 sequentially, the 
2nd Split Window will display Cam 17 to Cam 32 sequentially, the 3rd Split will 
display Cam 33 to Cam 48 sequentially and the 4th Split will display Cam 49 to Cam 
64 sequentially. Please refer to the following two figures. 
 

Display Cam 1 
to Cam 16 

 
 

Display Cam 1 
to Cam 16 

Display Cam 
17 to Cam 32 1

3
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sequentially  
  

 

 
  
 

 
  

sequentially 

Display Cam 
49 to Cam 64 
sequentially 

Display Cam  
33 to Cam 48 
sequentially 

sequentially 
st Split Window 

rd Split Window 4
2nd Split Window 
th Split Window 
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8  9 1 2 3 4 5 6 7 8 

9 10 11 12 13 14 15 16 
17 18 19 20 21 22 23 24 
25 26 27 28 29 30 31 32 
33 34 35 36 37 38 39 40 
41 42 43 44 45 46 47 48 
49 50 51 52 53 54 55 56 
57 58 59 60 61 62 63 64 

Group 1 16  1 

Group 2 

Group 3 

Group 4 

 

When you select 64-channel sequencer mode, these 64 cameras will be divided into 4 
sequencer groups with different color based on Camera No.1-16, 17-32, 33-48, 49-64. 
Each sequencer group will play sequentially based on camera number. As above 
picture Group 1 (1-16 camera), it will proceed sequencer to play s from camera 1 to 
camera 64 with the red arrow order, the other groups will proceed in the same wa. 

If you want to exit the sequencer mode, you can press “ESC” or click  to end the 

sequencer mode. 
  
If the system can connect 4 monitors at the same time, it can export the images to 
TV-wall by utilizing 4- channel or 64-channel sequencer mode. The main screen will 
be unchanged, and the 4 monitors will play 4 channel sequencer image. Besides, it 
can map the main screen into TV-wall composed of 4 or many monitors.   
 
Note: 

  64 Channel Sequencer can be available when the products have TV-wall 
function and must be equipped with VGA card supporting TV-wall. 
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4-3 Setup 

 

Setup

When you click the setup icon , you can see the following Setup menu. 

 

 
 

4-3-1 DVR Setup 
 
4-3-1-1 DVR Configuration 
Click DVR Setup button to set up the remote DVRs which you want to monitor in 
DrView when you login the system at the first time. Then, it will show the following 
screen.  
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 Add remote DVR 

Click  button to add new DVR. The system will appear a dialog box to prompt 

you to enter “DVR Name “, “IP Address”, “Port”, “Username”and “Password”. 

The DVR’s Name shown in the DrView doesn’t need to be the same with the remote 
DVR’s name. That means DrView Supervisor can create a new name for DVR in the 
DrView site. In addition, Supervision also can name the new names for all cameras 
connected to the remote DVRs in the DrView site. All of these new names are just for 
DrView site and it won’t change the names in DVR site.   

 

 

 

After finishing adding new DVRs, it will show the selected DVR information 
including connected cameras and DVR configuration when you point one of the DVR 
in the DVR list.  
 
Besides, you can adjust network speed based on real speed status, just click “ 56k”, 
“128k” , “256k”, “512k”, “768k” , “1M” for adjustment on the ComboBox. If you use 
company’s or school’s LAN, we suggest you can choose “ 1M” for quick 
display. For ADSL , Cable Modem , and Dial-up service , please adjust the setup 
based on real ISP speed.  
 
You also can adjust the image quality, just click “low”, “Medium”, “High” modes for 
adjustment on the ComboBox .We suggest you choose “High” for higher image 
Quality. However higher quality will occupy more system resources, network 
bandwidth, and it also cause to reduce the display speed.  
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Each DVR has remote monitor function. If you want to execute remote monitor, 

please click “ Enable” in the . If you don’t need it, please get rid of the 

“ Enable” in the . 

After finishing the setup or modifications, click  button to save the DVR 

changes. 
 

 

 

 

 Delete Remote DVR 
You can also delete monitoring the remote DVR. Just select the remote DVR you 

want to delete on the DVR List and then click  button. 

 
 Refresh remote DVR 

If you modified DVR configuration and want to save the latest setup, you can use  
Refresh function. Select the DVR you want to refresh in the DVR List, and modify 

the DVR configuration on the right side of System Setup screen, then click   

button to complete the action. 

After finishing refreshing DVR, click  button on the bottom of the System 
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Setup screen to exist the DVR Setup. The system will keep the latest setup status 
automatically. If there is any remote DVR disconnected, the system will show it as 

disconnected status  in DVR List. 

  
 

 DVR Remote Setup 

You can click Setup icon  to have the remote DVR and camera 

configuration.  
 

 

DVR advance setting 

 

When you click setup icon , it will show the following screen. 

You can have the “ Camera configuration”, Create or Edit “User” account, “ DI/DO” 
setup, “Alarm Notice”, “System setting” and “ Network” status”. Please refer to DVR 
User Manual to have detail setup for each items. After you finish the remote setup, 

click  button and press  button to exit the remote setup mode. 
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4-3-1-2 Alias Name 
You can click the icon of “ Alias name” to set up Alias name for camera, DI and DO. 
After you key in alias name for each camera, DI and DO, click “Apply” to save the 
names which you have set up.  

Set up Alias Name  

 

Setup Alias name for 

Camera/DI/DO 

Key-in Alias Name for 

each camera 

 
 
 



 
 

 
 

4-3-1-3 Event Activation 
You can set up “Alarm popup message”, “Alarm to Audio” or “ Motion to Zoom” 
when the events are activated from Camera, DI and DO.    
 
 E

 
 Camera Event configurat

 Motion Detect: 
 Enabled  
 Motion to Zoom 

 Alarm Popup Support 
 Motion  
 No Signal 
 Capture Fail 
 Ext Message Support 

When there is a motion or no sig
“ Popup message” to remind “A
 
You can define “Popup message
contact information, address, etc
 

 Alarm Audio Support 
 Motion 
 No Signal 
20

vent Activation 

 

Add Popup Message 

ion: 

nal or capture fail event occurring, you can enable 
dministrator” there are events occurring.    

” by yourself in “ Ext Message column”, for ex. 
.. 
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 Capture Fail 
When there is a motion or no signal or capture fail event occurring, you can enable 
“ Alarm to Audio” to remind “Administrator” there are events occurring. 
 
You can define the music you want to play when the event occurs. Go to the 
“Environment Setup”(Please refer to the 4-3-2 DrView Environment Setup) and 
click “ Alarm Audio” to set up the music you want to play for different event.  

 
 
You also can set up the Alarm Mode. The alarms configuration are applied for “ All 
event from DVR” or Current monitor camera”  
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 Save to Log 
 Motion 
 No Signal 
 Capture Fail 

Save the event to Log so that Administrator can look up any time. 
 

 DI/DO Event configuration: 
 Alarm Popup Support: 

 Enabled  
 Ext Message Support 

 Save to Log 
 Enabled 

 
When there is DI or DO event occurring, you can enable the “ Alarm Popup message” 
and define the “ Popup message.   
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4-3-1-4 Sequencer 
You can set up the display duration for individual camera.    
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4-3-1-5 Health Check 
 
DVR Ver 3.6 and above just can support Health Check function.  
 
There are two ways to get the DVR health status including Camera Status, HDD 
status and Reboot Info. One is from the “ Health Status” function in DVR Setup and 
the other one is DrView system automatically checks the DVR health status and save 
these health information in the database which can provide external application for 
usage.    

 

 
Go to the “Environment Setup”(Please refer to the 4-3-2 DrView Environment 
Setup) and click “ Health Check” to set up the “Disabled health check” or “ the 
frequency of Health check. If you select DrView system automatically checks the 
DVR health status, the health information will be saved in the database. 
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4-3-2 DrView Environment Setup 
When you click the setup icon , you can see the following Setup menu.  

 
 
Click “DrView Environment Setup” to proceed DrView Environment Setup. 

 



 
 

 
 

 

 DVR Connect--- Retry Times  
You can set up Retry Times for DVR reconnection. If DVR is disconnected, DrView 
will try to reconnect to the remote DVR actively. The number of reconnection is the 
one you set in the “Retry Times.”  

 Frame Color 
 Motion Detection: When motion happens, the frame of the motion channel 

will be marked with the color you set up here.  
 64 Channel Sequencer: In the 64 Channel Sequencer mode, the frame will 

be marked with the color you set up here.  
 Alarm Popup 

Enable or disable “alarm popup” function. 
 
Note 
64 Channel Sequencer mode just can be activated when DrView system is installed 
VGA card with TV wall function.  

 

4-4 Snapshot 

 

When clicking the left button o

the image of whole screen. 
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Snapshot 

f the mouse on the snapshot icon , you can capture 

 
S
ave 



 
 

 
 

 Click “ Save” and it will show the following dialog box. Select the folder you want 
to save the Snapshot picture and click “ save. The Snapshot of file format are JPEG 
file format.   

 
 

If clicking the right button of the mouse on the snapshot icon , you can capture 

the single split window which you select.    
 

 

4-5 Full Screen 

 

  

 

Click the “Full Screen ic
want to go back to main 
 

4-6 Motion to 

 

If you turn on the “ Moti
Full Screen

on” , you can enlarge any monitor to full screen. If you 
monitor screen, please press the “Space” to get back. 

Zoom 

on De
27

Motion to Zoom 

tect”(Refer to 4-1-2 Camera Option) and click Motion 
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to Zoom , the system will activate “ Motion to Zoom” function. You can change 

the Frame color of camera which has motion happening (Refer to 4-3-2 DrView 
Environment Setup). The mode of Motion to Zoom will be displayed in 13 split 
window. The latest motion will be always zoomed in Motion Zooming Area. If there 
is 2nd motion happening, it will replace 1st motion which was zoomed in Motion 
Zooming Area. Then, 1st motion will be put on the 1st split window. As this rule, if 
there is 3rd motion happening, 3rd motion will be zoomed in “ Motion zooming Area”, 
the 2nd motion will be put on 2nd Spilt Window. As this result, when the 14th motion 
happens, the 13rd motion will be put on 1st Split Window and repeat this rule.   
 

1st Spilt 
Window 

2nd  
 

Motion Zooming Area 
(Latest Motion) 3rd 4th

5th 6th 7th 8th

9th 10th 11th 12th 

 

 
 



 
 

 
 

4-7 Playback 

 

 
If you want to review the for

. The screen will show 

you want to review on the ri

 

4-7-1 Playback Contr
When you want to playback 
control panel.  
29

Playback 

mer recording video, please click the playback button 

the following screen and you can select the camera/DVR 

ght of screen.  

 

ol 
the selected camera, you can click the following playback 



 
 
 

 

Control Description 

Rewind Playback Rewind speed 
0.5X, 0.2X and 0.1X 

Forward Playback Forward speed: 
1.5X, 2.0X, 4X and 8X   

Play Playback the selected  
R

 
 

 ewind P

Forward

 

4-7-2 Do

 

 

 
Download 

Sna 

 Dow
You can d
icon and i
to escape 

 

video 
Previous 1 min Jump to preview 1 minute 

lay Next 1 min Stop 
P
 

 Previous 1 min. 

 

 

wnload/Disp

Full Screen 

Zoompshot 

nload 
ownload the selec
t will show the fol
the download mod

Save 
au

la

 

(+

ted
low
e. 
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Next 1 min Jump to next 1 minute 
Pause Pause the playback 
Stop Stop the playback 

se 

y 

/-)  

 

 video you want to save by clicking the “ Download” 
ing screen. Click Save to start to backup or click Exit 

 

Exit 



 
 

 
 

 Snapshot 
This function can provide you to capture the image you want and you can Print the 
image or Save the image. 
 

 Full screen 
Display in full screen. 
 

 Zoom  
There are 4 kinds of Zooming mode, 100%, 200%, Wide mode and Fit to Window.  

 
 

Print Save Exit  

 

 

4-8 E-MAP 

 

 
 
 
Be
EM
an
“E
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EMAP 

fore you start to enable the EMAP function in DrView, you need to build up the 
aps in EMAP Editor. Click “ Start” on your Windows taskbar, select “ Programs” 

d then find the folder of “ CenterManager200”. In this folder, please click the 
-MAP Editor” to execute the editor and it will show the following dialog box.. 
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Please select the DrView User Profile which you want to have EMAP function and 
enter the password to go to open the EMAP Editor (Only the administrator is 
authorized to create the E-MAP). Once you set up the EMAP profile in the EMAP 
Editor, you can start to use EMAP function in DrView manager. You just click EMAP 
icon in the DrView main menu.  
 

4-8-1 EMAP Editor 
When you successfully open the EMAP Editor, you can start to build your EMAP. 
EMAP Editor provides the functions that enable user to set up the locations of 
Cameras in the E-Map to help the administrator to have the connection between 
camera and Map. The MAP supports hierarchy structure and can let administrator 
easy to manage the remote cameras and DVRs.  

 



 
 

 
 

8 kinds of Camera Direction 

PTZ camera 

Create MAP Link 

Delete Camera 

Camera List 

Edit EMAP 

MAP List 

Delete EMAP 

 
 EMAP Format 

 Map should
 The size of m

 
 Create EMAP 

Step 1 Load/Add EM
Click “ Add” icon 
following dialog box. 

 

Click “ Load” icon 

MAP you want to Loa
Load/Add EMAP DI List 
 support JPEG o
ap should not 

AP:  
 to load MAP

 and 

d and click ope
33

r BMP fo
exceed 10

 into the E

it will sho

n.  
 

rmat. 
24*768.  

-MAP Editor and it will s

 

w the following dialog bo
how the 

x. Select the 
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You can see the MAP in the Preview Window. Enter the MAP Name and click OK. 

 
 

Then, you can see the MAP loaded into the EMAP Editor and the MAP name in the 
MAP List.  
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Step 2 Add Cameras/DI/DO in the MAP 
“Drag and Drop” the cameras, DI or DO from the right window of Server List to the 
MAP. You can decide the camera, DI or DO location in the MAP. To adjust the 
camera direction, you can click the one of 8 Camera Directions you want and the 
picture of camera on the MAP will change the direction immediately. You can also 
change the Camera in the MAP to PTZ Camera. Just click one of the camera in the 
MAP and this camera will be marked in a Red Frame to show the Selected status. 
Then, click PTZ camera icon and the selected camera will be changed to PTZ camera. 

You can delete the camera in the MAP by clicking the Delete icon .   

 Camera Direction 
 

PTZ Camera 

DO DI 

 
Note:  

 The Camera, DI and DO icons shown in gra
DO haven’t been set up. 

 The Camera, DI and DO icons shown in yel
and DO have been set up in this map. 

 The Camera, DI and DO icons shown in red
DO have been set up in other map. 

 One camera or DI or DO just can be set up o
 

 

PTZ Camera 
 

y color mean that the camera, DI and 

low color mean that the camera, DI 

 color mean that the camera, DI and 

ne time. 
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Step 3 MAP Link 
You can build another detail map for the specific area and make connection between 
these two MAPs. Just Add MAP and Drag and Drop cameras as Step 2 and the 
second MAP will show on the MAP List. You can switch the MAP by click the MAP 
name shown on the MAP list. 

 

 
To build the connection between two MAPs, just Drag and Drop the MAP Link icon 

 to the location of Major MAP and it will show the following dialog box. Click 

the Detail MAP you want to link and click “ OK”. Then, the MAP Link is completed.   

 
 
You can build more MapLinks in the Major MAP as the above method. However, You 
can’t build the MAP Link if only one map exits or the following dialog box will 
appear to remind you to add additional MAP. 
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Step 4 Save the EMAP 
Once you finish building the EMAP, please make sure to save the settings by clicking 
the “Save” in the file in the left upper corner of Window and click Exit to escape the 
EMAP Editor. 
 

 
 

If you want to delete the MAP, click the Delete icon . However, you need to 

delete all of the cameras in this MAP before you can delete this MAP.  
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You can also edit this EMAP by clicking the Edit icon . 

4-8-2 EMAP Operation  
When you finish building or editing an EMAP, you need to login to the DrView again 
to reload the new EMAP in the DrView. 
 

Click the EMAP icon  in the DrView to activate the EMAP function in the 
DrView and then you can see the following screen. 

 

Preview 
Window 

EMAP MAP List 

 

Link 

Information 



 
 

 
 

Click any camera in the MAP and you can see the camera image shown in the 
Preview window. Then, Drag and Drop the image from the Preview window to any 
Spilt window you want to monitor. 
 
When you click left button of mouse on the Map Link icon shown on the EMAP, you 
can see the Link location in the Link Information area. When you click right button of 
mouse on the MAP Link, it will jump to the linked MAP. 

 
The Map List window will be hidden when there is only one map in EMAP profile.   
 
There will be a “M” signal shown on the camera when the motion happens. If camera 
is no signal, “ NS” signal will be shown on the camera. 

 
 

4-9 Quick Select Ta

User can define the configuration 
that the selected split windows for
saved for next time use. With this 
fastest and more convenient.  
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M Signal 

g 

of Quick Select Tag from the ten options. It means 
 each DVR and camera at any split mode can be 
Quick Select Tag, you can switch to split window 



 
 

 
 

40

4-9-1 Save Quick Select Tag 
You can save your own Quick Select Tag by clicking . Then, enter the name of 
the Quick Select Tag in the following dialog box. and press “OK” to finish saving. 
 

 
 

You also can select “Default View” in advance, and you can use the selected option 
whenever you initialize the DrView and Auto-Login. 
 

4-9-2 Delete Quick Select Tag 
 

If you want to remove the unnecessary selected options, please select the Quick Tag 

you want to delete on the combobox, and press  to delete the Tag. 

 

 

4-9-3 Rename Quick Select Tag 
 

You can click Rename icon  to rename the name of Qick Select Tag. . 

                

4-10 Log System Status Window 

You can see the DVR status from the Log System Status Window.  
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 Camera Event: show the cameras with motion events.  
 Connecting Status: show all DVR connecting status. 
 DVR Status: show DVR status. 
 Channel Status: show each channel status. 
 Connecting Log: show each connecting log. 
 Log Search: Search the event log 

You can query the events according to time, event type, time, camera and DVR.    

 

Set up Event type, Time, Camera and DVR and click “Go” to list all of the event logs 
which are within the conditions you set up.   
 
Select one of the event log and click “ Playback” to playback the video of this log 

which you query directly. 
 

 

Select the log and 

click playback  
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4-11 Central Backup 

DrView Central Backup function enables administrator to back up local DVR files 
from remote side. Administrator just needs to select the camera, time and storage 
device and then can execute backup.        

4-11-1 Execute Central Backup program 
Click “ Start” on your Windows taskbar, select “ Programs” and then find the folder of 
“ CenterManager200”. In this folder, please click the “Central Backup” to execute 
backup program and it will show the following dialog box. 
 

 

 
 Log in 

Please select the DrView User Profile which you want to execute the backup. Because 
only administrator has the authority to back up DVR files, please open the User 
Profile by entering administrator’s password to login to the Central Backup.  
 

4-11-2 Set up Backup Schedule 
If DVR in the DVR list isn’t scheduled for backup, it will show “ No Backup 
Schedule Setup” in the left window of “ Backup DVR Information”.  



 
 

Task List 

Backup 
information 

DVR List 

 

DVR 
Backup
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Click “ File>Backup Schedule Setup” in task list to start to arrange the DVR backup 
schedule. It will show the following dialog box. Select DVR you want to arrange the 
backup schedule and click “ Modify schedule” in the left bottom of window.   

 
 
Then, it will show the following window. 

 DVR File List 
You can click each camera and it will span all of the recorded files of each camera and 
show them by date.  

 Backup Camera 
Select the cameras you want to back up. 

 Schedule 

status 

Modify 
Schedule 
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There are two types of backup schedule. One is backup by “Once” and the other one 
is by “ Periodical”.  

 Target Directory 
Select the directory where you want to save the files. You can choose the directory of 
local HDD or the Network Drive.  
   

 

Backup 
camera 

Backup 
Directory DVR File 

Date List Bandwidth 
Limit 

 
Backup Schedule 

 
 Bandwidth Limit 

Set up the maximum bandwidth of backup task. “0” means no limitation.  
 

4-11-3 Functions in Task list 
 Action>Suspend: Stop the backup task. 
 Action>Resume: Restart the backup task. 
 Options>Bandwidth Limit: Set up the limit of the total bandwidth and the 

maximum number of download files at the same time. 
 Options>Alarm: You can set up the HDD remaining size. When the size of 

HDD is smaller than this size, the system will send an alarm audio to warn the 
administrator.  

 Options>Recycling: You can set up the HDD reaming size. When the size of 
HDD is smaller than this size, the system will start to do the recycling. 

 Options>Login: When power fails and you restart the system, it will login by 
using these setup values. 

 File>Files check: This function provides you to check backup status. 
(1) “Lost”:   Check the whether the files you download are lost. Then, this file 
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will be recorded as “Lost ”. 
(2) “Not Found”: The file has been scheduled to be backuped and backup is not 

finished. However, you can’t find this file in DVR any more. Then, this file 
will be recorded as “ Not Found”.   

(3) “ CRC Error”: The size of file which is successfully backuped is not the as 
the one of file in DVR. Then, this file will be recorded as “CRC Error”. 

(4) “ Recycle”: The files are successfully backuped but these files are 
overwritten (Recycle) because the size of HDD is not enough. Then, this 
file will be recorded as “Recycle”. 

 

        
 
After finishing the “Files check” and finding unhealthy files (Lost, Not Found, 
CRC Error), the system will show the following dialog box. User can decide to 
download these unhealthy files again or ignore these files. If user decides to 
ignore these files, the system will not mark them as unhealthy file any more 
when he executes “Files check” next time.    
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4-11-4 Backup Information 
 DVR Backup status 

You can click any DVR in DVR list to see the total DVR backup status including 
backup settings, total backup files, backup size and remain sizes as the following 
picture.  

 

 
 Camera Backup status 

Double click the DVR in the DVR list and it will list all of the cameras connected to 
this DVR. Click the camera and you can see the backup statistics of this camera as the 
following picture..     

 

 



 
 

 
 

47

 File Backup status  
Double click the camera in the DVR list and it will list all of the dates with 
recorded files. Click any date and it will list all of the backup files in this date 
and the status of backup file.   

 

 
Double click any file in this backup file list and you can activate DVR player to 
play the file you backup directly. Click the right button of mouse on the file and 
it will show the directory where the file is saved.  
 
In the column of Schedule Status, you can see six types of file backup status. 
(1) Complete: Complete the downloading file. 
(2) Incomplete: File download is not completed. 
(3) Not Found: File can’t be found in DVR. 
(4) Deleted: Complete the file downloaded but file has been deleted by user. 
(5) GC: File is downloaded but overwritten due to HDD recycling. 
(6) Wait: File is not downloaded. 
 

 The state of DVR Backup task 
In the bottom of window, it provides the various information including Backup 
Task “Current Status”, “ System Log”, “ Connection Log”, “ Storage 
Information” and “Network Statistic”.   
In the “ Current Status” mode, there are 9 kinds of state in the column of 
“STATE” shown as following picture.   
 
 



 
 

 
 

 
 

(1) Sleep: It
(2) Wait: It’

over the
(3) Downlo
(4) Finish: B

backupe
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(5) Suspend
(6) Error: T
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Download” 
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Task state 

’s not the time to start the backup task. 
s time to start the backup task but the number of total backup tasks is 
 one you setting. 
ad: Files are being downloaded. 
ackup task has been finished but it doesn’t mean that all files are 

d. It is possible that some files are not backuped because they are 
ten due to DVR recycling.   
: Stop the backup task. 
here is an error during the downloading files. Please check logs. 
ing the error, please restart this task. 

ll: Disk is full and can’t execute backup.  
or: There is an unknown error happening in the disk. Please check 
  
There is no file to be downloaded in the arranging schedule. 

work Statistic” mode, it will show the current network flow as 
cture. “ Download Speed” is current average download speed. 
nload” is calculating the total download file size. When you click 
istic” icon, the number of “ Download Speed” and “ Total 
will be reset to “0”.   
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Note: 
Bandwidth Limit  

 Individual task bandwidth can’t exceed total bandwidth. 
 If all of the task bandwidth is set as “ No Limit”, they will share the total 

bandwidth averagely. 
 If the total task bandwidths are bigger then total bandwidth, all of the tasks will 

share the total bandwidth according to the proportion. 
 If not all of the task bandwidth are set as “ No Limit”, total bandwidth will 

assign to the tasks which are already set in advance according to the proportion 
and then the rest of bandwidths are assigned to the tasks set as “No Limit”.        

Others 
 Backup log files are saved in the directory of DrView and named as 

“ RBLog.mlb”. 
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4-12、Use Local Playback 

In the playback mode, you can download the video files ( Refer 4-7-2) by clicking the 

 and save the files in the directory. The files you download are CX3 format. If 
you want to play the file, you must execute “ DVR Player” from Windows 
taskbar->Start-> Program-> Central Manager 200 folder. 
 

 

 

 Click the  on the left down of the screen to open the video file and it will 
show the playing options as following,  

 Playback  

 Pause 

 Stop and go back the beginning of the film. 

 AVI Format Export: 
This function provides you to transform the download files from CX3 format to 
AVI format.  

 Open a download file.  
 In the “Tools’ bar, select “ Convert to AVI” and then select the path you 

want to save the AVI file and key in the AVI file name. 
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 Select the transforming format. Here we choose Microsoft MPEG 4 Video 
Codec.  

 
 Select transforming parameters and it will influence the file’s quality and 

size. 
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 Enter “ OK” and then it will show the transforming status. 
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5、Appendix 

5-1、Maintenance 
 Avoid placing the system at high temperature , high humidity , and also keep 

away from working in the frequent vibration environment.  
 Operate the system under the conditions of stable and high voltage, If possible, 

the system should be equipped with UPS ( Uninterruptible Power Supply ).   

5-2、FAE Support 
Any questions, please contact your supplier for your service. 
 
You also can visit our website : www.planet.com.tw for more information. 
Thank you !!    

http://www.planet.com.tw/
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